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Welcome 
 
About Backup Now Pro 
 

Welcome to Backup Now Pro 
This User’s Guide is unified in that Windows 10/8.1/8/7/Vista share common information. In each section, and as 

required, notes have been included where there are particulars pertaining to Windows 10/8.1/8/7/Vista operation, 
performance, or use.   

About Backup Now Pro 

Backup Now Pro handles the backup of your important files. Its intuitive user interface allows you to instantly 
navigate your way around your computer to locate files easily and the familiar Windows interface makes backing 
up your valuable data easy. Featuring our EasySteps™ interface, backing up or restoring your files is a simple 
four-step process.  

Step 1 – Select what files to backup/restore;  

Step 2 – Select where to backup or restore the data;  

Step 3 – Select when you want the data backed up or how to restore. 

Step 4 – Review and submit the backup or restore job. 

Backup Now Pro® now provides even more flexibility and power to meet your backup needs. New features 
include xml job format, job management monitor and data migration – all of this in addition to the extensive list of 
features provided in previous versions.  

Backup Now Pro offers the following advantages, making it the best and easiest solution for backing up 
your valuable data: 

• Backs up and restore files from NTI Cloud. 

• Takes advantage of 32-bit power of Windows 10/8.1/8/7/Vista and supports long file names. 

• Backup to CD-R/RW drives, DVD±R/±RW/±R DL/±RW DL/-RAM drives, jaz & zip drives and local and 
network attached hard drives. 

• User selectable file level backup and restore. 

• Supports new and changed file backups.  

• Supports data compression. 

• Backup data from any drive source connected to your computer. 

• Backup and restore across multiple discs. (Media Spanning) 

• Backup and restore across multiple hard drives. (Hard Drive Spanning) 

• Backup and restore using an FTP server. 

• Multi-burner support on CD & DVD devices. (Drive Spanning) 

• Run backup jobs instantly or schedule them for later execution. 

• Schedule backup jobs once or repetitively, on a daily, weekly or monthly basis. 

• Append backup data or overwrite existing data on CD/DVD-RW devices. 

• Exclude specific file types from file level backups. 

• Backup and restore your personal computer profile (Profile Backup) 

• Full backup and restore reporting. 

• Time sensitive file replacements on restore operations. 

• Restore data to alternate locations. 

 



 
   

Basic Configuration and Setup 
 
Toolbar 
 

Toolbar buttons are used as shorthand for menu commands. Each toolbar button represents a frequently used 
command. The display of these buttons is context-sensitive in that only buttons relevant to the current context 
are shown and enabled. 

 

Backup - Select this button to backup files.  

 

Restore - Control what, where, and how Backup Now Pro will do a restore 
operation from the Restore Options dialog. 

 

Migrate - Select how, what, and where to migrate data files. 

 

 

Menus 
 

All Backup Now Pro menus can be invoked by a single left-button click of a mouse on the menu title. Menu items 
are aligned on the left, with keystroke shortcuts (if applicable) displayed on the corresponding right side. The 
underlined character of a menu item, if pressed (through the keyboard), will have the same effect as if the menu 
item were selected with the mouse. 

 

Backup - Switch Backup Now Pro to Backup 
mode. 

Restore - Switch Backup Now Pro to Restore 
mode. 

Migrate - Switch Backup Now Pro to Migrate 
mode. 

Refresh - Refresh current window. 

Exit - Close the Backup Now Pro program. 

 

Create Recovery USB Flash Disk/USB HDD - 
Creates a bootable USB flash Disk or USB HDD 
which contains an image of your system partition.  

Create Recovery Disc - Creates a bootable 
CD/DVD which contains an image of your system 
partition.  

Erase Disc - Removes data on the disc. 

Disc Information - Displays disc's type, status, 
and other information.  

Optical Drive Properties - Shows optical drive's 
property information. 



 
   

Reports - Shows a completion report of every 
backup, restore or compare operation.  

Compare Files - Select what and where to 
compare backup files. 

 

Help Topics - Display the Backup Now Pro online 
help system. 

Register my NTI software - Links to NTI’s website 
to register software.  

Backup Now 6 Home Page -  Links to Backup 
Now Pro product page. 

Frequently Asked Questions Page - Links to 
Backup Now  Pro FAQ's web page. 

Software Update Download Page - Links to 
Backup Now Pro's   update/download page. 

Technical Support Page - Links to NTI’s tech 
support page. 

About Backup Now Pro - View the version 
number and program information about Backup 
Now Pro. 

 

Right-click Backup Now Pro icon on the system 
tray to access the Windows Services: 

Backup Now Services - Select to start or stop 
Backup Now  service. 

Launch Backup Now Pro - Open Backup Now Pro 
application. 

Help - Show help manual. 

Exit - Close the Backup Now Pro application. 

 

 

Using Backup Now Pro 
 
Getting Started 
 
Getting Started 
 

Getting Familiar with Backup Now Pro 

The first thing that you will notice about Backup Now Pro is how it automatically customizes itself based on the 
operation you wish to perform. You can select from the Backup, Restore, Compare and Migrate operations with 
the click of a button from the main toolbar and Backup Now Pro does the rest.  

EasySteps(TM) Interface 

Backup Now Pro splits these into separate steps for ease of use.  

 

Backup - Select this button to backup files.  



 
   

 

Restore - Control what, where, and how Backup Now Pro will do a restore operation 
from the Restore Options dialog. 

 

Migrate - Select how, what, and where to migrate files. 

Viewing Your Backup/Restore Jobs 

 

Select Continuous Backup for backing up specific files or 
folders on a continuous basis. You can select the 
number of previous file version to save, set default file 
names for backups or type a custom backup file name. 

 

Select File Based Backup for specific folder or profile 
backup such as your personal Microsoft Outlook(R), My 
Documents, Favorites bookmark, installed windows 
fonts, and the contents of your Desktop. 

 

Select Drive Based Backup for drive backups.  A 
backup set can be saved on any CD or DVD recorder on 
your computer or any device that provides drive letter 
access installed or connected to your system, including 
network hard disk. 

 

Select Cloud Backup for online backups.  You will need 
to login to your NTI Cloud account in order to back up 
your files online. 

 

 

Selecting files in Backup Now Using Backup Now Pro 
 

Selecting files in Backup Now Pro 

Backup Now Pro uses a Window's Explorer style view when you need to select specific files or folders for any 
step of the selected operation. The selection view is split vertically into two panes. The left pane, Collapsible 
Tree Pane, displays the system collapsible tree.  

• The right pane, File Information Pane, displays detailed information about items selected from the 
system collapsible tree.  

• Branches or nodes on the tree can be expanded or collapsed by clicking on the + or - to the left of the 
item or by double clicking on the item itself.  

• The two panes may be resized horizontally by dragging the splitter bar between them.  

• Dragging the splitter bar to the left will display more of the file information pane while reducing the visible 
portion of the collapsible tree pane. 

The file information pane has four columns that display the file/folder name, its size, the file type and the last 
modified date. The files may be sorted on any one of these columns by clicking on the column header.  

• By default, files are sorted alphabetically (ascending) by name. Click the Name column heading to sort 
them in descending order by name.  

• Items listed in the file information pane may include a small checkbox to the left of their name indicating 
that they can be selected within Backup Now Pro. Simply click the box to include that item and all items 
below it in the file structure in the current operation. For example, if you check the box to the left of the C: 
drive icon, all files and folders on your C drive will be selected automatically.  

• If you expand the C drive from the collapsible tree and then check the box to the left of the Autoexec.bat 
file then only the Autoexec.bat file is selected for the current backup, restore or compare operation. 



 
   

To Select a file/folder: 

1. Navigate the collapsible tree to locate the desired file, folder or drive. 

2. Check on the box to the left of the desired item. 

To Deselect a file/folder: 

1. Navigate the collapsible tree to locate the desired file, folder or drive. 

2. Uncheck on the box to the left of the desired item. 

 

Backup 
 
File Based Backup 
 
Step 1: What to backup? 
 

Step 1:   What to backup? 

1. Click on the Backup icon from the toolbar or select Backup from the File menu. 

2. Select the File Based Backup tab. 

3. If you wish to backup your profile, make sure you select the My Profile tab. Otherwise, use the My 
Folders tab to browse for the desired files and folders.  

4. Select the folders or files you wish to backup. 

5. Click the Next button to select the destination of the backup file. 

 

Step 2: Where to backup? 
 

Step 2:   Where to backup?  

1. Select one of the following destination for your backup files from the drop-down window: (a) Hard disc 
drives,  (b) Network drives, (c) Device with removable storage, and (d) FTP server. 

• If you have chosen to backup to a remote FTP server, enter the correct FTP server information. 

• Select more than one drive to hold your backup set (drive spanning) if your destination does not 
have enough space. 

2. Under the Priority column, you have the option to make a bootable CD/DVD (for removable storage 
only) for the backup. Simply check on the checkbox and select the drive(s).  

3. Change the corresponding backup file name if desired. 

File Based Backup File Extensions 

.
N
B
S 

The .NBS file defines the description of the file-based backup 
information and acts as an index for the application to search for data 
files. 

4. Click the Next button to select when and how to backup files. 
 



 
   

Step 3: When & How to backup? 
 

Step 3:   When to backup? 

1. Choose the backup type from the two options below: 

• Full Backup: Creates a new backup archive. 

• Incremental Backup: Backup will record only the changes since your last incremental backup. 

2. Select one of the following schedule options: 

N
o
w 

Backup files now. 

L
a
t
e
r 

Backup files at a later time only. Enter the start time and set the specific month, day, and year to begin 
backup. 

 

H
o
u
rl
y 

Backup files on a set hour. Enter the start time and select the hours and minutes to begin backup. 

 

D
a
il
y 

Backup files daily. Enter the start time and select the days to begin backup. 

 

W
e
e
k
l
y 

Backup files weekly. Enter the start time and select the day to begin backup from the drop-down 
menu. 

 

M
o
n
t
h
l
y 

Backup files monthly.  Enter the start time and select the day of the month to begin backup from the 
drop-down menu. 

 

3. Click on Next button to review the backup job. 

 

Step 4: Review and Submit 
 

Step 4:   Review and Submit 

1. Name the backup job under Job Name. You can add a description of the backup on the box below. 



 
   

2. Review the backup job setting. 

3. Click on Submit button to create the backup job. 

Once the job is created, Backup Now Pro Scheduler will execute the job based on your schedule settings.  

Notes: 

• The Track-At-Once (TAO) writing method is generally faster than Packet-Writing. However, Packet-
Writing is more reliable on slower systems or older CD burners. Backup Now Pro selects the 
recommended writing method based on your CD/DVD recorder. It is highly recommended that you only 
select the TAO writing method when your drive(s) support one of the buffer underrun protection 
technologies such as BurnProof™.  

 

Drive Based Backup 
 
Step 1: What to backup? 
 

Step 1:   What to backup? 

1. Click on the Backup icon from the toolbar or select Backup from the File menu. 

2. Select the "Drive Based Backup" tab. 

3. Select the drives you want to backup. 

4. Click the Next button to select where to backup. 

 

Step 2: Where to backup? 
 

Step 2:   Where to backup? 

1. Select one of the following destination for your backup files from the drop-down window: (a) Hard disc 
drives, (b) Network drives, and (c) Device with removable storage. 

• Select more than one drive to hold your backup set (drive spanning) if your destination does not 
have enough space. 

2. Under the Priority column, you have the option to make a bootable CD/DVD (for removable storage 
only) for the backup. Simply check on the checkbox and select the drive(s).  

3. Change the corresponding backup filename if desired. 

Drive Image Backup File Extensions 

.
N
P
S 

The .NPS (partition set) file is your drive image backup job data file 
index. It holds the description of the .NPF files.  Each backup job 
creates a .NPS file accompanied by one or more .NPF files. 

.
N
P
F 

The .NPF (partition file) files hold your drive image backup file. One 
.NPF file for every logical drive. For example, if you backup three drives 
(C:\, D:\ and E:\), you will have three .NPF files created. 

4. Click the Next button to select when and how to backup files. 

 

Step 3: When & How to backup? 
 

Step 3:   When to backup? 



 
   

1. Choose the backup type from the two options below: 

• Full Backup: Creates a new backup archive. 

• Incremental Backup: Backup will record only the changes since your last incremental backup. 

2. Select one of the following schedule options: 

N
o
w 

Backup files now. 

L
a
t
e
r 

Backup files at a later time only. Enter the start time and set the specific month, day, and year to begin 
backup. 

 

D
a
il
y 

Backup files daily. Enter the start time and select the days to begin backup. 

 

W
e
e
k
l
y 

Backup files weekly. Enter the start time and select the day to begin backup from the drop-down 
menu. 

 

M
o
n
t
h
l
y 

Backup files monthly.  Enter the start time and select the day of the month to begin backup from the 
drop-down menu. 

 

3. Click on Next button to review the backup job. 

 

Step 4: Review and Submit  
 

Step 4:   Review and Submit 

1. Name the backup job under Job Name. You can add a description of the backup on the box below. 

2. Review the backup job setting. 

3. Click on Submit button to create the backup job. 

Once the job is created, Backup Now Pro Scheduler will execute the job based on your schedule settings.  

 



 
   

Continuous Backup 
 
Step 1: What to backup? 
 

Step 1:  What to backup? 

1. Click on the Backup icon from the toolbar or select Backup from the File menu. 

2. Select the "Continuous" tab. 

3. Select one of the following backup options: 

B
a
s
i
c 

Once you have selected the folders and files, you can set up the Filters if 
you want to include or exclude certain file extensions from the backup 
job.  

To set up the File Type Filters: 

1. Backup Now Pro backs up all file types by default. If you want 
to include or exclude a certain file type, follow the 2 steps 
below: 

• Step 1:  Select or type in file type (Audio, Picture, Video, 
Document, Custom types) 

• Step 2:  Select Include or Exclude 

Note: 

You can select to include certain file extensions or 

exclude certain file extensions, but not both at the same 
time. 

The Include filter will back up only the files with the file 

extension(s) specified, whereas the Exclude filter will 
back up all files except for those with the extension(s) 
specified. 

2. If you want to manually type the file extensions, select “Custom 
types (*.exe;*.jpg)”. This will enable you to input the file 
extensions into the text box.   

To Input File Extensions Manually: 

• Begin by entering a star (*) and a ‘period’ (.) followed by 
the file extension code (Example:  To enter a JPEG file, 
you enter *.jpeg) 

• You can enter more than one file extension by separating 
each of them with a semicolon (;). 

• A caution dialog box will remind you to begin with the star 
(*) and the period (.) if you forget to enter them on the text 
box. 

3. Click OK to save changes. 

A
d
v 
a
n
c 
e
d 

Click on the checkbox next to the files you want to backup on the 
Collapsible Tree. You can include or exclude the file types under Step 
2 column. 

4. Click the Next button to select the destination of the backup file. 

 



 
   

Step 2: Where to backup? 
 

Step 2:  Where to backup? 

1. Click on the Browse button and select the folder where your backup will reside. 

2. Select one of the following options regarding the number of previous file versions to save: 

• Save all previous file versions 
Store the previous version on the backup destination when you make changes to a file. 

• Save a limited number of previous file versions 
Store the specified number of previous file versions on the backup destination when you make 
changes to a file. Enter a specified number on the textbox. 

• Do not save any previous file versions 
Do not store any of the previous file versions on the backup destination when you make changes 
to a file. 

3. Click the Next button to select when and how to backup files. 

 

Step 3: When & How to backup? 
 

Step 3:  When to backup? 

1. Select one of the following schedule options: 

H
o
u
r
l
y 

Backup files on a set hour. Enter the start time and select the hours and minutes to begin backup. 

 

D
a
il
y 

Backup files daily. Enter the start time and select the days to begin backup. 

 

W
e
e
k
l
y 

Backup files weekly. Enter the start time and select the day to begin backup from the drop-down 
menu. 

 

M
o
n
t
h
l
y 

Backup files monthly.  Enter the start time and select the day of the month to begin backup from the 
drop-down menu. 

 



 
   

C
o
n
ti
n
u
o
u
s 

Continuously backup files. 

2. Click on Next button to review the backup job. 

 

Step 4: Review and Submit 
 

Step 4:   Review and Submit 

1. Name the backup job under Job Name. You can add a description of the backup on the box below. 

2. Review the backup job setting. 

3. Click on Submit button to create the backup job. 

Once the job is created, Backup Now Pro Scheduler will execute the job based on your schedule settings.  

 

NTI Cloud Backup 
 
Step 1: What to backup? 
 

Step 1:   What to backup? 

1. Click on the Backup icon from the toolbar or select Backup from the File menu. 

2. Select the NTI Cloud Backup tab. 

3. If you wish to backup your profile, make sure you select the My Profile tab. Otherwise, use the My 
Folders tab to browse for the desired files and folders. 

4. Select the folders or files you wish to backup. 

5. Click the Next button to select the destination of the backup file. 

 

Step 2: Where to backup? 
 

Step 2:   Where to backup?  

1. Enter your email and password to your NTI Cloud account.  

• If you do not have a NTI Cloud account, click on the Sign Up button to register. 

2. Select the location of where you want to back up. 

3. Click the Next button to select when and how to backup files. 
 

Step 3: When & How to backup? 
 

Step 3:   When to backup? 

1. Choose the backup type from the two options below: 

• Full Backup: Creates a new backup archive. 



 
   

• Incremental Backup: Backup will record only the changes since your last incremental backup. 

2. Select one of the following schedule options: 

N
o
w 

Backup files now. 

L
a
t
e
r 

Backup files at a later time only. Enter the start time and set the specific month, day, and year to begin 
backup. 

 

H
o
u
rl
y 

Backup files on a set hour. Enter the start time and select the hours and minutes to begin backup. 

 

D
a
il
y 

Backup files daily. Enter the start time and select the days to begin backup. 

 

W
e
e
k
l
y 

Backup files weekly. Enter the start time and select the day to begin backup from the drop-down 
menu. 

 

M
o
n
t
h
l
y 

Backup files monthly.  Enter the start time and select the day of the month to begin backup from the 
drop-down menu. 

 

3. Click on Next button to review the backup job. 

 

Step 4: Review and Submit 
 

Step 4:   Review and Submit 

1. Name the backup job under Job Name. You can add a description of the backup on the box below. 

2. Review the backup job setting. 

3. Click on Submit button to create the backup job. 

Once the job is created, Backup Now Pro Scheduler will execute the job based on your schedule settings.  

 



 
   

Restore 
 
Step 1: What to restore? 
 

The Restore feature allows you to control what, where, and how Backup Now Pro will do a restore operation from 
the Restore Options dialog. 

Step 1:   What to restore? 

1. Click on the Restore icon from the toolbar or select Restore from the File menu. 

2. To restore a file, click on the File Based Restore tab above the window. Select Drive based Restore 
tab to restore a drive. You can restore from your NTI Cloud when you select NTI Cloud Restore (You 
will need to log in to your NTI Cloud account). 

3. Press on Browse button and select a specific backup file type to restore.  

4. Click on the Open button and select the folders or files you wish to restore. 

5. On Step 2 under Restore Point, select the time of the file when you want your file to restore to. 

6. For Step 3, select the file(s) you want to restore. 

7. Click on Next button to select the destination or where you want to restore the backup files. 

 

Step 2: Where to restore? 
 

Step 2:   Where to restore? 

1. Select to restore at its Original location or select Other location and specify the destination. 

2. Click the Next button to select how to restore your backup files. 

 

Step 3: When to restore? 
 

Step 3:  When to restore  

1. Select one of the following restore options: 
• Never replace a file with its backup copy 

• Replace a file only if its backup copy has a newer file date and time stamp 

• Always replace a file with its backup copy 

2. Select one of the following schedule options: 

N
o
w 

Restore backup copy now 

L
a
t
e
r 

Restore backup copy at a later time. Enter the restore start time and date. 

 

3. Click on Next button to review the restore job. 

 

Step 4: Review and Submit 
 

Step 4:   Review and Submit 

1. Name the restore job under Job Name. You can add a description of the restore on the box below. 



 
   

2. Review the restore job setting. 

3. Click on Submit button to create the restore job. 
 

Restoring files using Search 
 

Are you missing a file that you know you had previously backed up? You can search a specific file using Search 
(only available in File based Restore).  

To locate and restore a file with Search: 

1. Enter the name of the file you want to search on the box next to the Search button. 

2. Click on Search button on the right. 

Note: 
The find files feature supports standard wildcard searches such as *.doc to locate all Word documents 
in a backup or selected catalog. 

3. From the list of found files, select the files you wish to restore. 

4. Select the location of the restore, and set the restore options. 

5. Click the Start button to start the restore operation. 

Note: 
The Search dialog displays the location (disc number) of every file that meets your Find criteria. Please 
insert the correct disc before starting the restore process. In cases where you are restoring multiple 
files from multiple discs, Backup Now Pro will prompt you for each disc as required. 

 

Compare 
 
Compare Files 
 

You can compare original files to the backed up version of that file using the compare operation. File level 
compares can be run from a specific backup image or the catalog. You select the compare operation by clicking 
the compare icon on the main toolbar.  

Step 1:  What to compare? 

1. Select Compare Files from the Tools menu. 

2. Load the Collapsible Tree by clicking on the Browse button and select a specific backup file, or an 
FTP server.  

3. Click on the Open button and select the folders or files you wish to compare. 

4. Select the Compare destination at its original location or click the Browse button to select an alternate 
location.  

5. Once you have selected the files to be compared, simply click on the Start button to start the compare 
process. 

 

Migrate 
 
Step 1: What to migrate? 
 

The Migrate feature allows you to select how, what, and where to migrate data files. 

Step 1:  What to migrate? 

1. Click on the Migrate icon from the toolbar or select Migrate from the File menu 

2. Select the checkbox next to folders or files you wish to migrate. 

3. Click the Next button to select the migrate destination. 



 
   

 

Step 2: Where to migrate? 
 

Step 2:  Where to migrate? 

1. Choose the destination drive from the drop-down menu. 

2. Select the checkbox next to the folder or files you wish to migrate. 

3. Click on the Next button to select when and how to migrate. 

 

Step 3: When to migrate? 
 

Step 1:  How to migrate? 

1. Select one of the following migrate options: 
• Standard mode (Running as regular application) 

• Low priority (Only runs when your computer is not busy) 
This options allows you to start the task if the computer has been idle for an entered amount of 
minutes. If the computer has not been idle for that long, it will automatically retry for up to an 
entered amount of minutes. You can also move a slider to select a priority setting for this job. 

2. Select one of the following migrate schedule options: 

N
o
w 

Migrate files now. 

L
a
t
e
r 

Migrate files at a later time only. Enter the start time and set the specific month, day, and year to begin 
migrate. 

 

H
o
u
rl
y 

Migrate files on a set hour. Enter the start time and select the hours and minutes to begin migrate. 

 

D
a
il
y 

Migrate files daily. Enter the start time and select the days to begin migrate. 

 

W
e
e
k
l
y 

Migrate files weekly. Enter the start time and select the day to begin  migrate from the drop-down 
menu. 

 



 
   

M
o
n
t
h
l
y 

Migrate files monthly.  Enter the start time and select the day of the month to begin migrate from the 
drop-down menu. 

 

3. Click on Next button to review the migrate job.  

 

Step 4: Review and Submit 
 

Step 4:   Review and Submit 

1. Name the migrate job under Job Name. You can add a description of the restore on the box below. 

2. Review the migrate job setting. 

3. Click on Submit button to create the migrate job. 
 

Additional Features 
 
Job Management 
 
Managing Jobs 
 

On the Job Management window, click on the Operation button of the job to do one of the following options: 

• Run Job Now - Run backup job now. 

• Stop Running Job - Stop current backup job now. 

• Disable Job - Disables backup job from backing up. 

• Enable Job - Enables backup job. 

• Delete Job - Delete backup job. 

• Modify Job - Modify you backup configuration. 

• Refresh Job - Refresh current list. 
 

About your drives 
 
Drive Properties 
 

The Drive Properties dialog displays the read and write capabilities of the selected drive. Clicking on the Drive 
Properties icon on the Utilities Menu will display the Drive Properties for the selected drive. 

Write Capabilities: 
The write capabilities section indicates the supported write speed and indicates if the selected drive supports 
various features. 

• Dynamic Drive Support – "On" indicates that this drive was not in the Drive Support database and was 
detected by Dynamic Drive Support™. 

• CD Recordable – This drive writes to CD-R media at these speeds. 

• CD Rewritable – This drive writes to CD-RW media at these speeds. 

• DVD Recordable – This drive writes to DVD-R media at these speeds. 

• DVD Rewritable – This drive writes to DVD-RW media at these speeds. 



 
   

• Buffer Underrun Error Protection – This drive supports Buffer Underrun Error Protection. 

• Disc-At-Once – This drive supports the Disc-At-Once writing method. 

• Session-At-Once – This drive supports the Session-At-Once writing method. 

• Packet Writing – This drive supports packet-writing. 

Read Capabilities: 
The read capabilities section indicates the supported write speed and indicates if the selected drive supports 
various features. 

• Max Speed – This drive will read at this speed. 

• Read CD-RW (Multi-read) – This drive supports multi-read for CD-RW media. 

 

Disc Information 
 

You may wish to check information about a disc before you decide to import any session from the CD-ROM disc. 
To do this, choose Disc Information icon under the Utilities menu. The "Disc Info & Tools" dialog box will appear. 

This box contains informational fields about the disc, including its Disc Type, Capacity, Free Space. Status, and 
other details as shown below: 

Disc Type 
The disc type can be one of the following: (1) CD-DA or CD-ROM disc; (2) CD-I disc; (3) CD-ROM XA disc. 

Disc Status 

• Blank Disc: a blank piece of media is in the selected drive.  

• Recordable Disc: not a blank disc but you can still use this disc to record. That means the disc has not 

been finalized yet. 

• Unrecordable Disc: either a conventional CD/DVD or Disc has been finalized. You cannot use this disc 
to record. 

Re-Writable 
This field indicates the total recordable capacity of the disc, as expressed in megabytes (MB). If you insert a 
disc, this field will show you the exact capacity of the data stored on the disc. 

Used Space 
This field shows the amount of used space on the disc, as expressed in megabytes (MB). 

Free Space 
This field shows the free and available space on the disc, as expressed in megabytes (MB). If you insert a 
finalized or silver disc, this field will be zero, indicating no free space. 

Buttons  

• Refresh: When you insert another CD, click this button to display updated information about the new 
CD. Or, when you want to make sure that the contents of the currently inserted disc are correctly 
displayed, click on the Refresh button. 

• Erase: The erase button will be enabled if the disc in the selected drive is a erasable. You can erase the 
disc by clicking this button.  

• Close Session: If there are sessions that have remained open, when you highlight the open session, 
the Close Session button will be enabled. You can click it to close the selected session. 

 

Erase Disc 
 

You can erase your CD-RW media directly from the Backup Now Pro Tools Menu. You can choose either a 
Quick Erase or Full Erase. The quick erase function overwrites the existing table of contents, thus reducing the 
time it takes to erase a CD-RW disc to just a few minutes. The full erase function erases all data on the disc and 



 
   

takes a considerably longer amount of time to complete. A full erase however restores the CD-RW media to a 
more reliable state. 

To erase a CD-RW disc: 

1. Select the Erase Disc item from the Tools Menu. 

2. Select the CD-RW drive that contains the CD-RW media that you would like to erase from the CD-
RW Drive list. 

3. Select either Quick or Full for the Type of erase option. For reliability reasons, it is recommended 
that you choose the Full erase option. 

4. Click Start to begin erasing. 

 

Comparing Two File Folders 
 

It is possible to compare the contents of two folders on your system using Backup Now Pro’s Compare Files 

function. This utility is useful, for example, when you want to compare a backup copy to its original. Otherwise, 
this is a general tool for comparing the contents of similar directories. 

To compare the contents of two folders: 

1. Select Compare from the Tools Menu.  

2. Enter the locations of folders you wish to compare in each text field. If you don’t know the location 

of the folder, click on the browse button next to the text fields to search for the desired folders. 

3. Click on Start. 

The comparison result will show files that exist in one folder but not the other, files that are identical, and files 
that are different (i.e. "not compared"). 

 

Reports 
 
Completion Reports 
 

Backup Now Pro generates a completion report at the end of every backup, restore, or compare operation. 
These reports can contain a list of all files selected for a given operation and the status of the operation. You will 
want to view these reports to be sure that an operation was completed successfully. A report may be viewed 
upon the completion of an operation. All reports are saved in the Backup Now Pro Reports folder where they can 
be viewed later if necessary. 

 

Backup Reports 
 

To view a Backup Report:  

1. Select on the Report in the Tools menu. 

2. Backup Now Pro displays the Backup Report dialog box. 

3. Select the report you would like to view from the list of reports. 

 

Restore Reports 
 

To view a Restore Report:  

1. Select on the Report in the Tools menu. 

2. Backup Now Pro displays the Restore Report dialog box. 

3. Select the report you would like to view from the list of reports. 



 
   

 

Deleting Reports 
 

To Delete Reports:  

• On the Reports window, right-click on the file you want to delete on the left panel and select Delete 
from the drop-down menu. 

 

Options 
 
Setting Backup, Restore and Migrate Options 
 

You can control how Backup Now Pro performs backup, restore and migrate operations. You can click the 
Options button on either the Backup, Restore or Migrate function. 

To modify the Backup/Restore/Migrate options: 

1. Open the backup, restore, or migrate options dialog. 

2. Click on the appropriate tab for the options you wish to change. 

3. Select the desired option settings. 

4. Click OK to save your changes and close the selected options dialog box. 

Note: 

Clicking the Cancel button will close the options dialog box without saving your changes. 

 

Backup Options 
 
General Tab 
 

The General tab contains settings to select the compression method for the backup file and provide a media 
label. You may also specify whether you want Backup Now Pro to perform a comparison of the backed up file 
with the original when the backup file is created.  

Compare original and backup files to verify consistency 
Compares the contents of the original files to the data in the backup set. The verify process happens after a 
CD/DVD is full and before spanning to the next disc (if necessary). The backup file is opened and the data is 
decompressed and then compared to the contents of the original file. Verify can add several minutes to the 
total backup time. Uncheck this box to skip the verification process. 

Tone after the backup finished 
Backup Now Pro will sound an alarm tone (beeping) at the completion of a backup job when this box is 
checked. 

Data compression 
Normal data compression uses less space for the backup than no compression. It is also faster than using 
maximal compression. 

After Backup Options 
Select one of the following backup options: 
 

• Take No Action 

• Shut down 

• Log off 

• Hibernate 

• Standby 

 



 
   

Media Tab 
 

The options on the Media tab are used to select if a previous backup file is to be overwritten with the current one 
or the current backup file will be appended to the destination disc. In case of CD-R media, backup files are 
always appended to the end. 

Eject the media after backup is finished 
This option tells Backup Now Pro to eject the media once the backup job has completed. This is the default 
setting for this option. You may wish to disable this option in cases where you are running unattended 
backups and appending your backup jobs to the existing media. 

Name of media 
Enter the name of your media on the designated text box. 

 

My Profile Tab 
 

The My Profile tab specifies the folders to back up.  

To add and remove specific folders on the My Profile backup list: 

1. Use one of the following options under the My Profile Tab: 

• To add folders - Select and highlight a folder from the My Computer collapsible tree and click 
the Add button.  

• To remove folders - Select and highlight a folder from the My Profile list and click the Remove 
button. 

• To restore folders - Select and highlight a folder from the My Profile list and click the Restore 
button. 

2. Click on the OK button to save the changes. 

 

Filter Tab 
 

Once you have selected the folders and files, you can set up the Filters if you want to include or exclude certain file 
extensions from the backup job.  

To set up the File Type Filters: 

1. Backup Now 6 backs up all file types by default.  If you want to include or exclude a certain file type, 
follow the 2 steps below: 

• Step 1:  Select or type in file type (Audio, Picture, Video, Documents, Custom types) 
• Step 2:  Select Include or Exclude 

Note: 

You can select to include certain file extensions or exclude certain file extensions, but not both 

at the same time. 

The Include filter will back up only the files with the file extension(s) specified, whereas the 

Exclude filter will back up all files except for those with the extension(s) specified. 

2. If you want to manually type the file extensions, select “Custom types (*.exe;*.jpg)”. This will enable 
you to input the file extensions into the text box.   

To Input File Extensions Manually: 

• Begin by entering a star (*) and a ‘period’ (.) followed by the file extension code 
(Example:  To enter a JPEG file, you enter *.jpeg) 

• You can enter more than one file extension by separating each of them with a 
semicolon (;). 



 
   

• A caution dialog box will remind you to begin with the star (*) and the period (.) if you 
forget to enter them on the text box. 

3. Click OK to save changes. 

Note: 

The Restore Defaults button will clear any available file types the user has included or excluded. 

 

Security Tab 
 

Options on the Security tab determine if your backup files will be password protected. 

Enable Password Protection 
Selecting this option will add password protection to the file level or drive image backup. A password-
protected backup can only be restored by entering the correct password. 

Password  
Enter the password to be used for your backup file. 

Confirm password  
Verify your desired password. 

Enable Data Encryption and Use Password as Secret Key 
Enabling encryption on your backup adds an extra layer of security to your data. Selecting this option will 
encrypt any sensitive data in your backup file so that no one can read its contents. 

Encryption Key Size 
Encrypt your data using 128, 192, or 256-bit keys. A larger key offers increased security, but it will also 
increase the time needed to encrypt data. 

 

Notify Tab 
 

You can set your e-mail address on the Notify tab.  

How to set your e-mail address: 

1. Enter the following information on the Notify Tab: 

• From:  Correspondent e-mail. 

• To:  Recipient e-mail. 

• Cc:  Carbon copy. 

2. Click on OK to save changes. 

 

Advanced Tab 
 

Job Script 

Enables to complete a task before (Pre job script) or after (Post job script) the backup. 

 

Migrate Options 
 
Migrate Options 
 

You can control how Backup Now Pro will do a migrate operation from the Migrate Options dialog.  

To open the Migrate Options dialog: 



 
   

1. On the migrate window, click on the Options button. 

 

Migrate Tab 
 

Options on the Migrate Tab determine if the original copy is kept or deleted when you migrate files. 

Select one of the following options on the Migrate tab: 

• Keep original copy - File will be migrated to selected destination and kept on the original location. 

• Delete original copy - File will be migrated to selected destination and deleted on the original location. 

 
 


